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1 Overview

The Ticket Synchronization Framework enables the Ivanti Administrator to integrate the
various defect trackers viz. VSTFS, JIRA, Mantis, etc. into the Ivanti SM.

Through the integration, incidents created in lvanti SM are synchronized as issues in the
target defect trackers. The attachments and comments of the incident can also be
synchronized.

This user manual illustrates the functionality and usage of the Ticket Synchronization
Framework and how the administrator can configure the defect trackers.

2 Functionality & Scope

The Ticket Synchronization Framework comprises the following functionality and scope.

Defect Trackers supported currently.

Nk WNR

JIRA

GitHub

Bugzilla

Redmine

Mantis

VSTS

SalesForce

HP Quality Center

Functionality:

PwnNPE

Creating an Incident in lvanti SM creates an issue in defect tracker

Creating Comments in Incident creates comments in defect tracker

Creating Attachments in Incident creates attachments in defect tracker

Changing the status of the bug in defect tracker to closed updates the status of the
incident in Ivanti SM
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Connector Authentication Defect Sync Comment Incoming Outgoing
Support Support Attachment | Attachment
JIRA Basic Yes Yes Yes Yes
GitHub Basic Yes Yes No No
Bugzilla 5.0.3+ Query Params Yes Yes No No
Redmine 3.3+ Basic Yes Yes Yes Yes
Mantis 2.1.0+ SOAP Yes Yes Yes Yes
VSTS / TFS 2017+ Basic Yes Yes Yes Yes
SalesForce OAuth Yes Yes No No
HP Quality Center Cookies No No Yes Yes
Table 1

Important: The Synchronization between Ivanti SM and Defect Trackers is ONLY Uni-
directional and NOT Bi-Directional always.

Installing the Ticket Synchronization Framework

The Ticket Synchronization Framework comprises two packages to be imported

sequentially.

Package 1 — TicketSharingandSynchronization.MetadataPackage

Package 2 - TicketSharingandSynchronizationSampleData.MetadataPackage

1. Login into the Ivanti Service Manager management system Configuration Settings as
Administrator
2. From the left side Settings pane, Navigate to Build -> lvanti Development Package ->

Package

3. Click on the Import Package link on the top right
4. A pop up would be displayed as in Fig.1
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v

Administrator Admin

' Project:
Hel
&5 Administrator Default — ®
Settings EQ« Build » HEAT Development Package » Packages
Counters N R
Global Constants Show All v (13 search records) =
ey B NewRecord &' Refresh % Close Package 3 Export Package HSave As File A Import Package
Page Layouts
Pick Lists Name Open ¥ Modified On Modified By Created By Type Created (
Reports DSM Integration 2016.1 Yes 2/18/2016 8:24 AM FRS_JB joko incremental 10/21/20°
¥ Search Tools ntegr 12015.2.1 I rt Pack incremental 10,
mport Package
¥ User Interface Styles Delta Package 1 for NVI 5 J incremental 2/25/201¢
¥ Self Senice . i 12
et Please click button - Browse... to choose a package file. peremsntal 220
» HEAT Development Project 2016.1 Senvice Catalog for incremental 12/19/20°
v HEAT Development Package 2016.1 Portfolio Project M; incremental 2/4/2016
Packages 2016.1 Platform Changes incremental 12/18/20°
% Extend 2016.1 OrganizationalUnit incremental 1/9/2016
; 2016.1 New Self Service (f incremental 2/13/201¢
¥ Integration Tools
S A 2016.1 Identity Contract P| incremental 1/217201¢
¥ Voice Integration / > T = : ¢ o
HEAT DSM Integration 2016.1 Identity Contract In} rowse ... ancel incremental 1/9/2016
s 2016.1 ExternalContact In incremental 1/9/2016
SAP Integration
2 2016.1 Discovery Yes 1/14/2016 6:15 AM FRS_VasudevN... FRS_VasudevN... incremental 1/14/201¢
HEAT Discovery
HEAT API
I Monitor
» Application Logs
System Audit History < >
Patch Logs Page Size Best Fit A Page 1 of1 5]
Sehediled .Inhs %
Fig.1
5. Click Browse
6. Navigate to the location where the package 1 file is available as shown in Fig.2
@ File Upload X = a X
] 1 <« packages > Defect sync vio o X T+
Organize v New folder m @ ¢ Q search wBA 9 3 a S 8§ e - - =
Incident A Name N Date modf|
Issue T
- U 11-08-2016| . Administrator Admin Project: @ Help @
icket Sharing a1 0 11-08-2016 & @ Administrator Default
s g e
[ This PC +q
[ Deskiop o
[El Documents V€ 2 e Package @ Export Package |—JSave As File "8 Import Package
Fil : [T i ization. | | AllFil |
e e | TikeishaingandSynchiorization. | EREES V‘ en ¥  Modified On Modified By Created By Type Created (
VHEATD Project Import Package
¥ HEAT Development Package
ckages Please click button - Browse... to choose a package file.
% Extend
¥ Integration Tools
¥ Voice Integration < >
HEAT DSM Integration Page Size Best Fit e 1 of 1 5]

SAP Integration
HEAT Discovery
HEAT API
M Monitor

¥ Application Logs
System Audit History
Patch Logs
Scheduled Jobs v

Fig.2




Ivanti

Ticket Synchronization Framework

7. Select the Package 1 TicketSharingandSynchronization.MetadataPackage
8. Click Open

9. APop upisdisplayed as shown in Fig.3

Settings

Page Layouts

Pick Lists

Reports
¥ Search Tools
¥ User Interface Styles
P Self Service
» HEAT Development Project
¥ HEAT Development Package

ckages

% Extend
¥ Integration Tools
» Voice Integration
HEAT DSM Integration
SAP Integration
HEAT Discovery
HEAT API
FIMonitor
» Application Logs
System Audit History
Patch Logs
Scheduled Jobs

B New Record

Name

No data found

<

Administrator Admin
aln & Administrator

EQK Build » HEAT Development Package » Packages
Show All v

(no records found)

& Refresh X

Open ¥ Modified On Modified By Created By

Import Package

Please click Preview Impact to scan the package complexity.

File Name: Ticl dSynchronization. MetadataPackage

Show Detail: O

Page Size Best Fit v

Preview Impact = Skip Preview

@' Export Package | Save As File

Cancel

Project:
® Help
Default @

s

"B Import Package

Type Created (

Q

Fig.3

10. Click Skip Preview
11. The pop up with the three Operation Types are displayed as shown in Fig.4

4

Settings
P Automation Tools
Business Objects
Object Explorer
Validation Business Objects
> Workflow
¥ Charts and Graphs
Counters
Global Constants
Mobile Layouts
Page Layouts
Pick Lists
Reports
¥ Search Tools
¥ User Interface Styles
P Self Service
» HEAT Development Project
¥ HEAT Development Package
Packages

% Extend

¥ Integration Tools
¥ Voice Integration

[ ] Administrator Admin

Show All v (no records found)

Bl NewRecord & Refresh X

Name

No data found

<

Page Size Best Fit

It is very important to back up the database before applying the package because
package import is irreversible. Contact your database administrator.

File Name: Ti ynchroni

Data MetadataPackage
Operation Type: O Validate
@ Validate and apply if no errors

O Apply without validation (Not recommended. You assume all responsibility to correct errors after import.)

Execute

Project:
aln & Administrator Default

EQ K Build » HEAT Development Package » Packages

@' Export Package | Save As File

Import Package

Cancel

@ Help @

+Q

@ Import Package

Created (

Fig. 4
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Select the second Operation Type “Validate and Apply if no errors”
Click Execute
The package would be imported and applied successfully and a message displayed

15. Repeat the steps from 7 to 13 for Package 2
Note:
1. The package 1 - TicketSharingandSynchronization.MetadataPackage after import

comprises the web scripts / quick actions for all connectors and sample data for JIRA and
VSTFS connector services ONLY

If the customer wants the sample data for other supporting connector services, then import
the package 2 — TicketSharingandSynchronizationSampleData.MetadataPackage

4 Administrator Workspaces

1.
2.
3.

Login as Administrator

Click More

Check for the Defect Sync specific workspaces as shown in Fig.7
a. Constants

Connector Service

Connector Service Transaction

Ticket Sharing and Synchronization

oo o

) ) Administrator Admi Configure Applicat
P-, + ® Home - Incident - Service Request - Problem - Change -  More... 0 i o Conbourc bplcation O -
-l S )\ Adeninictratar 2 WENNPN
W Search objects v > X # Watch List v
Show Admin Dashl My Workspace Tas are Installation splay Bl EC2Servers » o

My Incidents (16)

— Summary,  Business Value Modeling
Calendar ltem Identity Store
10931 PCisvery 1o P
10890 email dow.  cenificate Location Additional workspaces  CI
10945 Daily Bacl  Change Calendar Portfolio Account
10924 Mobile Ph I Project Actity Call Result
10936 Daily Bach ~ Cl Location Releass Agent Skill
11084 Windows1 CLM EC2 Account C Report Agent Task
11048 reportinc] ¢ Request Offering Alert
10647 Software Ii Announcement
10648 Computer Approy
11100 Whidows1 .

Analytic Metrics r Configuration  TaskCataloy

"

Assat Data Mapping Transaction Audit Log

>!

Baseline Mapping

Attachment S
Alarmvb Authentication Provider DS

ged Installation State
EXECUIVE SCUIRCIY - SLW

Gateway Status Summary

Hardware Inventory Summary

Incident Categorization

Incident Cost

Incident Customer Rating

Fig. 7
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4.1 Constants
The connector web service scripts will interact directly with the Ivanti Service Manager data

using the web service API. To do so, the scripts need access to the API, so login credentials and
location are required, and can be supplied through this dialog.

As the integration was created under the HEAT Software corporation, the values use HEAT

instead of Ivanti.

1. Login as Administrator
e. Click More and search for the Constants workspace
f. The Constants workspace would be displayed with pre-configured values

(Refer Fig.8)

) ) Administrator Ad Configure Applicati
+ ® Home - Incident - Service Request - Problem ‘- Change - More... s 2 Gt it
aln & Administrator ® Help

Show All v (1-7 of 11 search records)

[E New Constants X Delete > Refresh

Name 7 Value v Is Mask

HEATSeniceName FRSHEATIntegration false

HEATSenicePassword true

HEATSeniceRole Admin false

HEATSeniceTenantID TESTENV false

HEATSeniceURL http://192.168.124 251/HEAT/SeniceAPI/FR .. false

HEATServiceUsername admin false

TenantiD heatupdate-stg.saasit.com false

Page Size Best Fit v 4] Page 1 of2 | »
Constants

Name HEATSeniceTenantiD

Value TESTENV Is Mask

Home EOIEENE » Watch List v
ey

o -

Q

Fig. 8
To edit a particular constant value, double click the constant record.

The constant edit view would be displayed as shown in Fig.9
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P-’ + ® Home - Incident - Service Request - Problem - Change -  More... ‘,. :’:g::::‘;’;:‘i’"‘" 25::‘:9”'5’App"°a"°“ o -
Show All v (record 5 of 11 search records) € = a
A List View [E} New Constants 2 Save & Refresh
Constants
Name | HEATSeniceURL

Value  http://192.168.124.251/HEAT/SeniceAPI/FRS  Is Mask []

Fig.9

Edit the values in the Constant record to match your tenant.

Check the Is Mask option if you want the Value field data to be masked.
Click Save

The new values would be updated.

Each of the Constants fields is explained below.

1. HEATServiceName:

Name of the Service. This is fixed and should normally not need to be
changed.

2. HEATServiceUsername:

e Username for accessing the HEAT Web Service API.

3. HEATServicePassword:

Password for accessing the HEAT Web Service API
4. HEATServiceRole:

Role for the accessing the HEAT Web Service API
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5. HEATServiceTenantID:

e Tenant ID that the API will use for the Web Service API. This should be your
current tenant name.

6. HEATServiceURL:
e URL of the HEAT Web Service API.
o Ifyou are a cloud tenant, this should be in the format
https://yourtenant.saasit.com/ServiceAPI/FRSHEATIntegration.asmx/
o If you are a premise tenant, this should be in the format
https://yourtenant.saasit.com/HEAT/ServiceAPI/FRSHEATIntegration.asmx/
7. TenantlD:
e Tenant URL, same as HEATServiceURL
8. TenantPassword:
e Password of the Tenant, same as HEATServicePassword

9. TenantRole:

e Role of the Tenant, same as HEATServiceRole
Note:

1. Constants 1 to 6 are used for Attachment Sync
2. Constants 7 to 9 are used for Issue / Comment Sync

4.2 Ticket Sharing & Synchronization

This workspace must be configured by the administrator to define the credentials to
access the Defect Management system, and to define the field and data mappings.

4.2.1 View

The list of all the integrations is displayed as shown in Fig.10
The list displays the following details

1. Name (Integration Name)


https://your/
https://your/
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2. Business Object Name
3. Service Name
4. Status

z ] Administrator Ad Configure Applicati
+ ® Home - Incident - Service Request - Problem - Change -  More... o D N, A Cartuts Sogkeation @ &
aln & Administrator ® Help

Ticket Sharing and Synchronization » Watch List v

Show All v (1-7 of 10 search records)

*Q
[E New Ticket Sharing and Synchronization X Delete < Refresh
Name T Business Object Name™  Senvice Name ¥ Status
Bugzilla Connector Incident Bugzilla Enabled
GitHub Connector Incident GitHub Enabled
HP Quality Service Conn...  Incident HP Quality Center Enabled
JIRA Connection Incident JIRA Enabled
Mantis Connector Incident Mantis Enabled
Redmine Connector Incident Redmine Enabled
Sale force Connector Incident Salesforce Enabled
Page Size Best Fit v 4] Page 1 of2 » M &

Ticket Sharing and Synchronization
Integration Name  Bugzilla Connector
Business Object Name  Incident

Status Enabled

Fig.10

4.2.2 Edit

Following is the sequence of steps to edit an existing ticket sharing and synchronization.

1. Double click a Connector Service Connection from the list
2. The edit view of the selected Connector Service Connection is displayed with
Prepopulated data as shown in Fig.11



Ivanti
Ticket Synchronization Framework

o < Ad trator Ads Confi Applicati
+ ® Home - Incident - Service Request - Problem - Change -  More... 0 SO Pt A\ Cantiuts Applcation @ a
aln & Administrator ® Help
Ticket Sharing and Synchronization » Watch List v
Show All v (record 10 of 11 search records) € > Fiy

A List View [E New Ticket Sharing and Synchronization 3, Save & Refresh
Ticket Sharing and Synchronization

Integration Name | VSTFS Connection
Business Object Name  Incident v

Status  Enabled v
Credentials Filters (1) Field Mapping (2) Data Mapping (2) ~ Data Rules (1)  Additional Operations Comment Field Mapping (2)

Service Name = VSTFS Q
Service URL  https://heatconnector.visualstudio.com/
Username  HEAT Admin

Password esesssesss

Fig.11

3. Set the Status depending on whether you want the integration to run or not
4. Inthe credentials tab, update the fields as required
a. The Service URL is the url which the Defect Management application host
is accessed.
i. E.g.salesforce.com might be https://na3.salesforce.com depending

on your location.

ii. If the url to the Web Service API of the integration in question is
different than your tenant, use the host name where the
integration is accessed.

5. Edit Filter
a. Click the Filters Tab
b. Double Click the filter from the list
c. Apop up is displayed with the filter values prepopulated as shown in Fig.12


https://na3.salesforce.com/
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. . Administrator Admin Configure Application
+ ® Home : Incident - Service Request - Problem - Change -  More... [ ] & N, Connie ai o -
aln & Administrator ® Help
Ticket Sharing and Synchronization »# Watch List v
Show All v (record 10 of 11 search records) € > A
A List View [El New Ticket Sharing and Synchronization > Refresh
- - =
Integration Name = VSTFS Connection
Business Object Name  Incident Edit Connector Service Filters X
Status  Enabled
Filters
Credentials = Filters (1) Field Mapping (0) = Data Mappi Incident Field Name  Category ¥
[ New Connector Senice Filters X Délete Incident Field Value International Dialing Failure ]
Operation with next Filter OR v
Business Object Field Name Business Object Fiel
Note: Following filter uses the Operation field if we have another filter
Category International Dialing
Save Cancel
Page Size 10 v Page 1 of 1 (5]
v

Fig.12

d. Edit one or more values
e. Click Save
f. The modified values are updated
g. Click Cancel to retain the existing values
6. Edit Field Mapping
a. Click the Field Mapping Tab
b. Double Click the mapping from the list

c. A pop upis displayed with the values prepopulated as shown in Fig.13

. - Administrator Admin 9, Configure Application
+ ® Hol - Incident - rvice Request - Problem - Change - More... [ ] A
F fEseNIncid SeRiceReqlies el ehang aln & Administrator @ Help (D

Ticket Sharing and Synchronization » Watch List v
+Q

Show All v (record 10 of 10 search records) € >

A List View [E} New Ticket Sharing and Synchronization 3 Save & Refresh

s i ~
Ticket Sharing and Synchronization Edit Connector Service Field Mapping x

Integration Name = VSTFS Connection

Field Mappin
Business Object Name  Incident Pping
Incident Field Name | Description v
Status Enabled
VSTFS Field Name  System Description

Credentials Filters (1) Field Mapping (5) Data Mappi Service Field Depth = System Description
[E New Connector Service Field Mapping X Delete Provide default value []
Poll this field for h,
Senice Name byl Dyl PO this fleld forany Slianges I
VSTFS System.Description Description
VSTFS project
VSTFS System State Status o Cancel
VSTFS Alternate Col
VSTFS System.Title Summary true

Fig.13
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Edit one or more values
Click Save
The modified values are updated
Click Cancel to retain the existing values
7. Edit Data Mapping
a. Click the Data Mapping Tab
b. Double Click the data mapping from the list
c. Apop up is displayed with the values prepopulated as shown in Fig. 14

on.—hgno.

Y ) Administrator Ad Configure Applicat
+ ® Home - Incident - Service Request - Problem - Change -  More... i A, Condaes: tpplicaton (D =
alm & Administrator ® Help

Ticket Sharing and Synchronization @ Watch List v
+Q

Show All v (record 11 of 11 search records) €

A List View [l New Ticket Sharing and Synchronization & Save & Refresh

Ticket Sharing and Synchronization

Integration Name ~ VSTFS Connection

Business Object Name  Incident Edit Connector Service Data Mapping X

Status Enabled

Data Mapping

Credentials | Filters (1) Field Mapping (5) Connector Service Field Incident=AltemateContactEmail - VSTFS= ¥

[El New Connector Senice Data Mapping X D Incident Field Value  Closed

Senvice Field Name Senice Field Val VSTFS Field Value | Closed

System State " Closed Stop polling after this value

System.State Active

Save Cancel

Page Size 10 v Page 1 of 1 2 |

Fig.14

Edit one or more values
Click Save
The modified values are updated
Click Cancel to retain the existing values
8. d t Data Rules
a. Click the Data Rules Tab
b. Double Click the Data Rule from the list
c. A pop up is displayed with the values prepopulated as shown in Fig.15

m:.—hgno.
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) ) Administrator Admi Configure Applicati
+ ® Home - Incident - Service Request - Problem ‘- Change - More... mm's.r.m o N, Gorfums et (D =
aln @& Administrator ® Help

Ticket Sharing and Synchronization » Watch List v

Show All v (record 10 of 11 search records) € = 2

A List View [l New Ticket Sharing and Synchronization & Save & Refresh

Ticket Sharing and Synchronization

Integration Name VSTFS Connection
Edit Connector Service Field Constraint
Business Object Name  Incident

Status  Enabled Field Constraint
Field ing Value ject = VSTF: Y  Desc v
Credential Filt 1 Field Mapping (2 Data M:
(TS it ) e Mapping ©) el Business Object Field Name  ActualCategory v 4
B New Connector Senvice Field Constraint X Delete Business Object Field Value ' Name
Display Name Business Object Fi
Incident=Subject :: VSTFS=System.D ActualCategory Save Eancel
v
< >

Fig.15

. Edit one or more values
. Click Save
The modified values are updated
g. Click Cancel to retain the existing values
9. Edit Additional Operations
a. Click the Additional Operations tab
b. The additional options are displayed as shown in Fig.16

o Qo

bal

o - Administrator Admin 9, Configure Application
F ® z o 2 c : More... 4
+ Home - Incident - Service Request - Problem - Change e an Th @ Help @

Home  Constants Ticket Sharing and Synchronization » Watch List v

Show All v (record 10 of 11 search records) € 2

A List View [E] New Ticket Sharing and Synchronization 3, Save & Refresh

Ticket Sharing and Synchronization
Integration Name  VSTFS Connection
Business Object Name  Incident v

Status  Enabled w
Credentials Filters (1) =~ Field Mapping (2) ~~ Data Mapping (2) ~ Data Rules (1) = Additional Operations Comment Field Mapping (0)

Push Comments added in HEAT to VSTFS

8]

Comment Business Object Journal#Notes 4

Pull Comments added in VSTFS to HEAT

]

Push Attachments added in HEAT to VSTFS
Pull Attachments added in VSTFS to HEAT

9
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Fig.16

c. Check / Uncheck one or more options
d. Click Save
e. The modified values are updated
10. Edit Comment Field Mapping
a. Click the Comment Field Mapping Tab
b. Double Click the mapping from the list
c. Apop up is displayed with the values prepopulated as shown in Fig.17

: ) Administrator Ad Configure Applicat
+ ® Home - Incident - Service Request - Problem - Change -  More... [ ] OSanaemh A Conauis Appiicaton o -
alm & Administrator ® Help

Ticket Sharing and Synchronization » Watch List v
+Q

Show All v (record 10 of 11 search records) € =
A List View [E] New Ticket Sharing and Synchronization & < Refresh

Ticket Sharing and Synchronization

Integration Name VSTFS Connection

Edit Comment Field Mapping

Business Object Name  Incident

Status  Enabled
Incident Field Name | Notes

Credentials | Filters (1) Field Mapping (2) ~ DataMappind ~ VSTFS Field Name | Summary
[} New Comment Field Mapping X Delete Incident Default Value | Summary

Business Object Field Name Senvice Field Name
Notes Summary Save Cancel

Fig.17

Edit one or more values
Click Save
The modified values are updated
g. Click Cancel to retain the existing values
11. Click Save
12. The modified data is updated

-0 o
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5 Connector Service Transaction

The connector service transaction workspace lists all the transactions for the
synchronizations between lvanti and Ticket Synchronization Frameworks.

The list of transaction records is displayed as shown in Fig. 18

o - Administrator Admin 9, Configure Application
W + ® Home - Incident - Service Request - Problem - Change -  More... o A
o g aln  #& Administrator ® Help @
Connector Senvice Transaction  Watch List v
Show All v (17 of 22 search records) Y
[El New Connector Transaction X Delete &> Refresh V¥ Action menu v
ParentLink T TSSReclD ¥ Type ¥  Senice Name T Senice Unique ID ¥ Is Complete ¥ Created By ¥ Created
BEA3A505B4F44A3CADBBB...  C13379786F9B4B0DA2DBD34C2A080C06 Incident HP Quality Center 4 true InternalSenvi...  8/26/2 ~
CAF2B4F9A09D4A37ABIF2F C13379786F9B4B0DA2DBD34C2A080C06 Incident HP Quality Center 3 false InternalSenvi 8/26/2
7D8F9471AE534DCEBDODF...  86EA232B466F4EC2850BB17619AE5137 Incident Salesforce 5002800000PUDKBAAS true InternalServi...  8/24/%
F0749A3DA20842F1B752BE...  86EA232B466F4EC2850BB17619AE5137 Incident Salesforce 5002800000PUD7fAAH true InternalSenrvi...  8/24/2
574392EA32174D9B845C53D... 6A56A2FC3CFB4BFC9758112F0846F8F4 Incident Redmine 193 true InternalServi 8/241
8263136ABIA64218A4FTBE...  6A56A2FC3CFB4BFCI758112F0846F8F4 Incident Redmine 192 false InternalSenvi...  8/24/2
MPNRCIINCARRIAEIAAERIN FANNRCEARIAEARERA ANEANGARATROINRA Inridant na anann deaa Intarnal 1QAna amar Y
< >
Page Size Best Fit v A Page 1 ofd  » M 57
~
Ticket Sharing and Synchronization
ParentLink BEA3A505B4F44A3CADBBB5A87422452F
TSSReclD  C13379786F9B4B0DA2DBD34C2A080C06
Service Name  HP Quality Center
Service Unique ID 4
v

Fig. 18
The list displays,

. ParentLink

. TSSRecID

. Type

. Service Name

. Service Unique ID
. Is Complete

. Created By

. Created On

0O N O U1 A W N B

The transaction records are created and displayed for each of the following
synchronization action.

Create Issue
Comments Outgoing
Comments Incoming
Attachments Outgoing

nkwNe

Attachments Incoming
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6. SynclIssue



Ivanti

Ticket Synchronization Framework

The list of Synchronization Actions for all the Ticket Synchronization Framework Services is

displayed as shown in Fig.19

P-’ + ® Home - Incident - Service Request - Problem - Change -

Home  Constants Connector Senvice Transaction: New record

Show All v (record 15 of 22 search records) € >

Ticket Sharing and Synchronization
ParentLink
TSSReclD
Service Name
Service Unique ID

Is Complete []

Comment Ti i
B New Comment Transaction @ Link &2 Unlin
Comment ID ¥ Connector Transaction ID

No data to display

More...

Administrator Admin
alh & Administrator

@ Help

9, Configure Application

o -

# Watch List v

A List View [l New Connector Transaction M Save > Refresh

> Goto

¥ NotelD

¥ Is HEAT Related

T Created By ¥

@] Bugzilla Create Issue

3] Bugzilla Sync Comments Incoming
3] Bugzilla Sync Comments Outgoing
2] Bugzilla Sync Issue

3] GitHub Create Issue

@] GitHub Sync Comments Incoming
@ GitHub Sync Comments Outgoing
3 GitHub Sync Issue

@3] HP Create Issue

3] HP Sync Attachments Incoming
3] HP Sync Attachments Outgoing
3] HP Sync Issue

3] JIRA Create Issue

@] JIRA Sync Attachments Incoming

ey

¥ Action menu v
Connector  »

% Edit Actions

@) JIRA Sync Attachments Outgoing
3] JIRA Sync Comments Incoming

Fig.19

Executing Action Scripts
This section describes the usage of each of the Action Scripts.

The user can execute each of the Action scripts for the various configured Ticket
Synchronization Frameworks as follows.

1. Inthe Connector Service Transaction list, double click a transaction record for a specific
connector

2. The details of the transaction are displayed as shown in Fig.20

Parent Link

TSSReclID

Service Name

Service Unique ID (Unique ID generated in the connector service)

Is Complete (Flag whether the corresponding incident is Closed or Not)

S oo 0 T w

Two tabs
i. Comment Transactions
ii. Attachment Transactions
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Administrator Admin 9, Configure Application ® N
aln & Administrator ® Help

Home Constants Connector Semvice Transaction » Watch List v

Show All v (record 9 of 22 search records) € > Fiy

W + ® Home - Incident - Service Request - Problem ‘- Change - More...

A List View [El New Connector Transaction 3, Save > Refresh V¥ Action menu v
ParentLink 4CDA179A27B34F299F58E2256555290D o
TSSReclD  805D9D2A02D34CCC8B551E2969A5B960
Service Name VSTFS
Service Unique ID 137
Is Complete []

Comment Ti 8) Ti @)

=] New Comment Transaction X Delete (& Link g2 Unlink = Goto
+ (%

Comment ID ¥ Connector Transaction ID ¥ Note ID ¥ s HEAT Related v Created By ¥ Created On ¥

10 18A2F0AASF114EE8B4DI0DFEF C4DBO74A8CE642669...  true Admin 8/24/2016 1: A
1373 18A2F0AASF114EEBBADIODFEF...  CTAATE2BBFFB41F2..  false Admin 8/24/2016 1:...

137_6 18A2F0AA5F114EE8BADIODFEF 9895DI3EAEAE49069 false Admin 8/24/2016 1

1.0 18A2F0AASF114EEBBADIODFEF...  9F13B0C60946449D9B... true Admin 8/24/2016 1:...

1.0 18A2F0AA5F114EE8BADIODFEF E4A20FCICEA443EE true Admin 8/24/2016 1

1.0 18A2F0AASF114EESBADIODFEF...  FCA267B7953840B9B...  true Admin 8/24/2016 1:..

Fig.20

Create Issue

e Create an Incident in Ivanti SM; creates an issue in the target Defect Connector
and then the corresponding transaction record gets created
e User can validate whether the Issue got created in the target defect connector
by checking the Service Unique ID value
o If the value is not displayed immediately, click the Refresh link at the top
of the grid
o If the value is displayed, that means the Issue got created
e For some reason, if the issue does not get created in the defect connector
service, the service unique Id will be blank as shown in Fig.21
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o - Ad trator Admi Confi Applicati
+ ® Home - Incident - Service Request - Problem - Change More... [ ] S et N Sounts Apolication o -
a & Administrator ® Help
Home Incident Saved Search: All Active Incidents ent: 11096 Connector Service Transaction » Watch List v
Show All v (1-7 of 23 search records) x
[E New Connector Transaction X Delete &> Refresh V¥ Action menu v
ParentLink ¥ TSSReclD v Type Senvice Name ¥ Senvice Unique ID ¥ Is Complete ¥ Created By ¥ Created
E9ATB6C7F4354EE1B32311...  805D9D2A02D34CCCBB551E2969A5B960 Incident VSTFS false InternalSemvi...  8/29/2 ~
BEA3A505B4F44A3CADBBB...  C13379786F9B4B0DA2DBD34C2A080C06 Incident HP Quality Center 4 true InternalSenvi...  8/26/
C4F2B4F9A09D4A37ABIF2F... C13379786F9B4BODA2DBD34C2A080C06 Incident HP Quality Center 3 false InternalServi...  8/26/%
7D8F9471AE534DCEBDODF...  86EA232B466F4EC2850BB17619AE5137 Incident Salesforce 5002800000PUDKBAAS true InternalServi... 824/
F0749A3DA20842F1B752BE B86EA232B466F4EC2850BB17619AE5137 Incident Salesforce 5002800000PUDTfAAH true InternalServi 82412
574392EA32174D9B845C53D... 6A56A2FC3CFB4BFCI758112F0846F8F4 Incident Redmine 193 true InternalSenvi...  8/24/2
QIRAMACARAARAVIIRAAETAE EARBAIECACERARENOTEQ44IENRAREQAEA Inridant Dadmina 109 Falen IntarnalQana amar Y 4
£ >
Page Size Best Fit v A Page 1 ofd » M 2

Ticket Sharing and Synchronization

~

ParentLink E9A7B6C7F4354EE1B32311765F0FD6F3
TSSReclD  805D9D2A02D34CCC8B551E2969A5B960
Service Name VSTFS

Service Unique ID

Fig.21

e |n this case, the user can select the transaction record related to the connector
service, click the Action Menu -> Create Issue (For the selected Connector
Service) to explicitly create the Issue

e The Issue gets created and the Service Unique ID is displayed as shown in Fig.22

F’ + ® Home - Incident - Service Request - Problem - Change

Home Incident Saved Search: All Active Incidents

. Administrator Admin 9, Configure Application

More... A
al & Administrator @ Help @

Incident: 11096

Show All v (1-7 of 23 search records)

[E! New Connector Transaction

ParentLink T TSSReclD ¥ Type Senice Name T Senice Unique ID Is Complete ¥ Created By ¥ Created
E9A7TB6CTF4354EE1B32311...  805D9D2A02D34CCCBB551E2969A5B960 Incident VSTFS 138 false InternalSenvi...  8/29/2 ~
BEA3A505B4F44A3CADBBB... C13379786F9B4B0DA2DBD34C2A080C06 Incident HP Quality Center 4 true InternalServi 8/26/2
C4F2B4F9A09D4A3TABIF2F... C13379786F9IB4BODA2DBD34C2A080C06 Incident HP Quality Center 3 false InternalServi...  8/26/Z
7D8F9471AE534DCEBDODF B86EA232B466F4EC2850BB17619AE5137 Incident Salesforce 5002800000PUDKBAAS true InternalServi...  8/24/Z
F0749A3DA20842F1B752BE...  86EA232B466F4EC2850BB17619AE5137 Incident Salesforce 5002800000PUD7fAAH true InternalServi...  8/24/2
574392EA32174D9B845C53D... 6A56A2FC3CFB4BFC9758112F0846F8F4 Incident Redmine 193 true InternalSemvi 8/241%
(ﬂ’n:‘n‘chnQAt:A’HﬂAA:'IQI: RAEGAIENACERARENOTEQR119ENRAREREA tonidant Dadening 109 falon It nrnalCnai QI’M)/’ N 4
Page Size Best Fit v A Page 1 ofd » M | 2

X Delete & Refresh

Ticket Sharing and Synchronization

ParentLink E9A7B6C7F4354EE1B32311765F0FD6F3

TSSRecID  805D9D2A02D34CCCBBE51E2969A5B960

Service Name VSTFS

Service Unique ID 138

Connector Senice Transaction

ey

WV Action menu v

~

Fig.22



1. Comments Outgoing

Create Notes) as shown in Fig.23

Ivanti

Ticket Synchronization Framework

Navigate to the created incident record and add a comment (Under Journal —

W + ® Home - Incident - Service Request - Problem ‘- Change

ident Saved Search: All Active Ini

Incident: 11098 r Senvice Tran:

Show All Active Incidents v (record 1 of 64 search records) € >

A List View [E NewIncident v\ Apply Template v

UL S daSIUETHU LUTT

More...
alb & Administrator

A, Save @ Refresh # Pinlt @ Share (% Assign Incident to Me Add New Task %Close Incident A‘PAdd Problem 9 Print Incident  »

team;: | Semcetiask M Resolution Target: 9/3/20" A
7195551254 — : g Related Items »
Owner  Administrator Admin v =\
VTFS issue creation Q
Details ~ Task (0)  Master Incident -+ Knowledge (13) a fal
How do | report an Issue using a Templ
Sty Attachimiant Bszel Review the list of commonly reported
VTFS issue creation Q (@ Attachfile [ Paste from clipboard & Link 2 Unlink issues in the Report an issue using
— template pane.
Description 4
e - e y
Description for isssue creation in TFS How do | report a New Issue?
Journal ,  Review the list of commonly reported
@ Croate v 22 Unink ishuee e Mt i SRR iy
Email wn i ?
¢ . . N lve my ow
t- Created in issue in VSTFS with id 139 Howdol res.olle SR issue
Notes While reporting a new Issue, you can
resolve it immediately if a Knowledge
Service Mobile Communication v Remote Control Session article provides a resolution.
v = Voice Activity Log £ 11098 has been logged for you Add a User Account to BlackBerry Ent..
Calegony [ntemstionsl Mislingheslie ” 2l i Admin,The following new Incident has b Add a User Account to BlackBerry
Source Phone - 8/29/2016 5-03 PM #11098Summary:VTFS issue creationCustomer Name:A Enterprise Server Software v5.0 and

AdminLocation:USAPriority:3Status:ActiveCa

Administrator Admin

9, Configure Application ® N

® Help

# Watch List v
Q

Search for Incident

Higher

Fig.23

A comment would be added for the incident as shown in Fig.24

W + ® Home - Incident - Service Request - Problem - Change

Home Incident Saved Search: All Active Incidents Incident: 11098 Connector Senvice Transact

Show All Active Incidents v  (record 1 of 64 search records) €

A List View [E New Incident v v Apply Template v

U@ S S IUETTIU LU

7195551254

¥, Save

leam | Service Desk

Owner

Details ~ Task (0) Master Incident

Summary Attachment

VTFS issue creation (@ Attach file
Description

Description for isssue creation in TFS
Journal

@ Create ¥

Administrator Admin

[ Paste from clipboard

Administrator Admin

More...
alm @& Administrator

© Refresh  # Pinlt @ Share 4% Assign Incident to Me  #85Add New Task  &Close Incident  443Add Problem 9 Print Incident  »

Resolution Target: 9/3/20° A BEEYEGRICH o) »

v

v —V

+

Asset

& Link &2 Unlink

ZR Unlink

. from summary

from notes

Service  Mobile Communication

InternalServices

Category 8/29/2016 5:04 PM

International Dialing Failure

Source  Phone

Incident# - Created in issue in VSTFS with id 139

9, Configure Application
® Help

o -

» Watch List v
Q

Search for Incident 2

Q

N~

VTFS issue creation

Knowledge (13)

How do | report an Issue using a Templ
Review the list of commonly reported
issues in the Report an issue using
template pane.

How do | report 2 New Issue?
Review the list of commonly reported
issues in the Report an issue using
template pane.

How do | resolve my own issue?
While reporting a new Issue, you can
resolve it immediately if a Knowledge
article provides a resolution

Add a User Account to BlackBerry Ent
Add a User Account to BlackBerry
Enterprise Server Software v5.0 and
Higher

Fig.24
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e Now navigate back to the transaction record view

e C(lick the Action Menu at the top right

e Click Connector

e List of all action scripts for the various integrated connector services are
displayed

e Scroll to the required connector service item

e For example, click TFS Sync Comments Outgoing as shown in Fig.25

o - Administrator Admin 9, Configure Application
W + ® Home - Incident - Service Request - Problem - Change -  More... o A
o g aln  #& Administrator @ Help @
Home  Ticket Sharing and Synchronization Business Objects Change Connector Senvice Transaction # Watch List v
Show All v (record 1 of 24 search records) € > = =
2] Redmine Create Issue
A List View [E} New Connector Transaction N, Save &> Refresh @) Redmine Sync Attachments Incoming V¥ Action menu v
Service Name  VSTFS i@ Redmine Sync Attachments Outgoing Connector  »
Service Unique ID 139 i) Redmine Sync Comments Incoming & Edit Actions
Is Complete [] @) Redmine Sync Comments Outgoing
——————— @] Redmine Sync Issue
Comment Ti () Ti ions (3)
2] Salesforce Create Issue
[E! New Comment Transaction X Delete (&’ Link g2 Unlink - Goto ¥8) Salesforce Sync Comments Incoming
Comment ID ¥  Connector Transaction ID ¥ Note D ¥ s HEAT Related ¥ Created By 7 @] Salesforce Sync Comments Outgoing
139_6 09CF28AT726514E5F925335B1149...  62B98F8D3C3A433DA... false InternalSeni.. i3] Salesforce Sync Issue 2
1.0 09CF28AT726514E5F925335B1149 CF4339AE4A1A42378 true InternalServi @) TFS Create Issue
139 4 09CF28AT726514E5F925335B1149...  14E0D4A250C64D808... false InternalServi.. y
1.0 09CF28A726514E5F925335B1149...  578259FES9CB4A2A93... true Admin &) TFS Sync Attachments Incoming
139_3 09CF28AT726514E5F925335B1149...  1D7127957AF2474EA.. false Admin @] TFS Sync Attachments Outgoing
139.2 09CF28AT26514E5F925335B1149 63CEA4E388C04B8DI..  true Admin ) TFS Sync Comments Incoming )
Page Size 10 v @3] TFS Sync Comments Outgoing o
i3] TFS Sync Issue ¥
< . >

Fig.25

e A new Comment transaction record would be created and displayed in the
Comment Transactions tab

e Login and Check in the TFS Connector Service

e The comment added in Ivanti Incident would be synced successfully and
displayed in the TFS Issue as shown in the Fig.26
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Team Services /  MyFirstProject rekhaakshintala | @ & © @

HOME CODE WORK BUILD TEST RELEASE P~

Backlogs ~Queries

SSUE 133

~ New )
139 VTES issue creation
Assigned to me *

e & -
Followed work items [ rehaakshintala &2 [Addtag Swe @ Follow O

Unsaved work items . <
State ® Active Area MyfFirstProject Updated by rekha.akshintala just now

4 Recent work items

New MyfFirstProject Details 9 & 1]

Issue 139
~

4 My favorites
Drag queries here to add them to y...
4 Team favorites

Drag shared queries here to add the... i i
Discussion i3 s
» My Queries

b Shared Queries

rekha.akshintala commented just now
From VTFS to HEAT

[ rekhastshintala <
* from summary
from notes

@ Recycle Bin
v

d 2 minutes ago

Fig.26

2. Comments Incoming

e Navigate to the TFS Issue
e Addacomment to that issue as displayed in Fig.27

D Team Services /  MyFirstProject rekhaakshintala | @ &% @ ©
HOME CODE WORK BUILD  TEST  RELEASE ea t i
Backlogs  Queries
< W ssuee N :=
~ New fO
139 VTEFS issue creation
Assigned to me * :
[ rekha.akshintala &1 Add tag Save @ Follow O
Followed work items
Unsaved work items . 2 <
State ® Active Area MyFirstProject Updated by rekha.akshintala a minute ago
4 Recent work items N - :
Reason New Iteration MyfFirstProject Details 9 & (]
Issue 139
"
4 My favorites
Drag queries here to add them to y...
4 Team favorites
Drag shared queries here to add the...
» My Queries
» Shared Queries Discussion e
R ent. Use 21
V‘“u«] rekha.akshintala commented o minute ago
from summary
from notes
@ Recycle Bin
v

Fig.27

e Now navigate back to the transaction record detail view
e Click the Action Menu at the top right

e Click Connector

e Scroll to the required connector service item
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e Click TFS Sync Comments Incoming as shown in Fig.28
T " Administrator Admin Configure Application
+ ® Home - Incident - Service Request - Problem - Change More... e : BN Con Byl o -
alb @& Administrator @ Help
Home  Incident Saved Search: All Active Incidents Incident: 11098 Connector Senice Transaction
Show All v (record 1 of 24 search records) € = Y
2] Redmine Create Issue
A List View [E New Connector Transaction 3 Save &> Refresh i) Redmine Sync Attachments Incoming ~ Action menu v
i i Connector  »
Ticket Sharing and Synchronization &) Redminis Sync Attachments Outgoing 4
: i Edit Actions
ParentLink  2A253D8526F244C4A3653012E83DFCA4 ll i ocine SyncGommstis lncomig
@] Redmine Sync Comments Outgoing
TSSReclD  805D9D2A02D34CCC8B551E2969A5B960
3] Redmine Sync Issue
Service Name VSTFS
3] Salesforce Create Issue
Service Unique ID 139
ol @) Salesforce Sync Comments Incoming
Is Complete [] 4
2] Salesforce Sync Comments Outgoing
Comment T @ T © 2] Salesforce Sync Issue
% 3] TFS Create Issue
B New Comment Transaction X Delete (& Link 2 Unlink 2 Goto
@3] TFS Sync Attachments Incoming
Comment ID Connector Transaction ID ¥ Note D ¥ Is HEAT Related ¥ Created By ¥ ) TFS Sync Attachments Outgoing
1392 09CF28AT726514E5F925335B1149...  53C5A45388C04B8DY...  true Admin lies Syne Commenta mcomng
1.0 09CF28AT726514E5F925335B1149...  F324EB89EC1D54F638...  true InternalServi... t
@) TFS Sync Comments Outgoing
@) TFS Sync Issue
. v

Fig.28

e A new Comment transaction record would be created and displayed in the

Comment Transactions tab as shown in Fig.29

) ‘ Administrator Admi Configure Applicati
+ ® Home - Incident - Service Request - Problem ‘- Change A s S Arissin (D =
aln @& Administrator ® Help

Home  Constants Connector Senvice Transaction » Watch List v

+Q

More...

Show All v (record 9 of 22 search records) € >

A List View [El New Connector Transaction 3, Save > Refresh V¥ Action menu v
ParentLink 4CDA179A27B34F299F58E2256555290D L)

TSSReclD  805D9D2A02D34CCC8B551E2969A5B960
Service Name VSTFS
Service Unique ID 137
Is Complete []
Comment Ti 8) Tr 2) 1

B New Comment Transaction X Delete (& Link &2 Unlink - Goto

Comment ID ¥ Connector Transaction ID ¥ Note ID ¥ s HEAT Related ¥ Created By ¥ Created On ¥

1.0 18A2F0AA5F114EESB4DIODFEF. CADBO74ABCE642669...  true Admin 8/24/2016 1: A
1373 18A2F0AASF114EEBBADIODFEF...  CTAATE2BBFFB41F2..  false Admin 8/24/2016 1:...

137_6 18A2F0AA5F114EE8BADIODFEF 9895DI3EAEAE49069 false Admin 8/24/2016 1:

1.0 18A2F0AASF114EEBBADIODFEF...  9F13B0C60946449D9B... true Admin 8/24/2016 1:...

1.0 18A2F0AA5F114EE8BADIODFEF E4A20FCICEA443EE...  true Admin 8/24/2016 1:...

1.0 18A2F0AASF114EESBADIODFEF...  FCA267B7953840B9B...  true Admin 8/24/2016 1:... o

Fig.29

and displayed successfully as shown in Fig.30

Check the incident record in Ivanti, a new comment would be synced from TFS
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W + ® Home - Incident - Service Request - Problem ‘- Change

More...

&% Administrator

Administrator Admin ¥

9 Configure Application
® Help

o -

# Watch List v

Show All Active Incidents v (record 1 of 64 search records) €

A List View [E NewIncident v+ v Apply Template v 2 Save ' Refresh »* Pinlt @ Share <% Assign Incident to Me
UESCIPULN 101 ISSSUE Creauon i irs
Journal ~
@ Create ¥ 22 Unlink
Admin VSTFS (139_3)
8/29/2016 5:7PM  From VIFS to HEAT
Service Mobile Communication v
Admin from summary
Category International Dialing Failure v 8/29/2016 510 PM o notas
Source  Phone v
Impact Medium v InternalSenvices Incident# - Created in issue in VSTFS with id 139
8/29/2016 5:04 PM
Urgency Medium v
Priority 3
no-reply@frontrange.....  Incident# 11098 has been logged for you
Declare as Master Incident i Hi Admin, The following new Incident has b
Update Related Incident 8/29/2016 5:03 PM #11098Summary:VTFS issue creationCustomer Name:#
. AdminLocation:USAPriority:3Status:ActiveCa
Resolution
no-reply@frontrange.....  Incident# 11098 is assigned to your group
5 3 v

Hi iro Dack Tha fallawina lncidant has b

Q 2

Search for Incident

FEAdd New Task  §Close Incident & Add Problem %9 Print Incident  »

Related Items

»
Q

Knowledge (13) a ol

How do | report an Issue using a Templ
Review the list of commonly reported
issues in the Report an issue using
template pane.

VTFS issue creation

How do | report a New Issue?
Review the list of commonly reported
issues in the Report an issue using
template pane.

How do | resolve my own issue?
While reporting a new Issue, you can
resolve it immediately if a Knowledge
article provides a resolution

Add a User Account to BlackBerry Ent

Add a User Account to BlackBerry
Enterprise Server Software v5.0 and
Higher v

Fig.30

3. Attachments Outgoing

Fig.31

Navigate to the created incident record and add an attachment as shown in

W + ® Home - Incident - Service Request - Problem - Change

Home Incident Saved Search: All Acti

Show All Active Incidents v (record 1 of 64 search records) € >

A List View [El NewIncident v+ v Apply Template v ok Save & Refresh »* Pinlt @ Share % Assign Incident to Me Add New Task %Close Incident A}Add Problem  # Print Incident  »
~
Summary Attachment Asset Related [tems »
VTFS issue creation Q (@ Attach file [ Paste from clipboard @ Link &2 Unlink VTES issue creation Q
Description
Ki ledge (13)
Description for isssue creation in TFS warning jpg
WM | Admin 8/29/2016 5:19PM How do | report an Issue using a Templ
Review the list of commonly reported
issues in the Report an issue using
Journal template pane
@ Create ¥ 22 Unlink How do | report a New Issue? )
el NOBIEC — ,  Review the list of commonly reported
ervice  Mobile Communication v i i
i VSTFS (139.3) ;sesmues in the Report an issue using
3 = = plate pane
Category International Dialing Failure v 8/29/2016 5:17 PM From VTFS to HEAT
How do | resolve my own issue?
Source  Phone b 2 While reporting a new Issue, you can
- Admin from summary resolve it immediately if a Knowledge
Impact  Medium ¥ 8/29/2016 5:10 PM from notes article provides a resolution.
Urgency  Medium i Add a User Account to BlackBerry Ent
{orif . i i i Add a User Account to BlackBer
P 3 InternalS - Ty
riority nterna BM,CES Incident# - Created in issue in VSTFS with id 139 Enterprise Server Software v5.0 and
Declare as Master Incident 8/29/2016 5:04 PM 4 Higher "

More...
alm @& Administrator

Administrator Admin

9, Configure Application
® Help

@ “

» Watch List v
Q

Search for Incident 2

Fig.31
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e Now navigate back to the transaction record view

e Click the Action Menu at the top right

e Click Connector

e Scroll to the required connector service item

e For example, click TFS Sync Attachments Outgoing as shown in Fig.32

: < Administrator Admin Configure Application
+ ® Home - Incident - Service Request - Problem - Change -  More... o e - N Comaus Apnica o -
alb @& Administrator @ Help
Home  Incident Saved Search: All Active Incidents Incident: 11098 Connector Senice Transaction A Watch List v

Show All v (record 1 of 24 search records) € = 2
@] Redmine Create Issue

A List View [} New Connector Transaction 3 Save & Refresh @) Redmine Sync Attachments Incoming ¥ Action menu ~

v

Connector

& Edit Actions

Ticket Sharing and Synchronization 5 Redring Syfc Altachiments QGG
Parentlink  2A253D8526F244C4A3653012E83DFCA @ Redmine Sync Comments Incoming
@) Redmine Sync Comments Outgoing
TSSReclD  805D9D2A02D34CCCEBE51E2969A56960
3] Redmine Sync Issue

Service Name VSTFS
2] Salesforce Create Issue

Service Unique ID 139
i3] Salesforce Sync Comments Incoming

Is Complete [] 4
Iz @] Salesforce Sync Comments Outgoing
Comment Ti (3) T ions (0) i3] Salesforce Sync Issue

@) TFS Create Issue

[E! New Comment Transaction X Delete (&’ Link g2 Unlink & Goto
3] TFS Sync Attachments Incoming

Comment ID ¥ Connector Transaction ID ¥ NoteD ¥ s HEAT Related ¥ Created By ¥ @) TFS Sync Attachments Outgoing
139 3 09CF28AT726514E5F925335B1149...  1D7127957TAF2474EA...  false Admin

o 5 @) TFS Sync Comments Incoming
139_2 09CF28AT726514E5F925335B1149 53C5A45388C04B8D9. true Admin
10 09CF28AT26514EEF92633581149...  F324EB9ECTDS4F638...  true InternalServi.. & TFS Sync Comments Outgoing

3] TFS Sync Issue

Fig.32

e A new attachment transaction record would be created and displayed in the
Attachment Transactions tab as shown in Fig.33

. " Administrator Ad Configure Applicati
+ ® Home ° Incident - Service Request - Problem - Change -  More... ] o el S oty Apication @ =
alm & Administrator ® Help

Home Constants Connector Service Transaction »* Watch List v

Show All v (record 9 of 22 search records) € =)

A List View [l New Connector Transaction M, Save < Refresh W Action menu v
~

Service Name VSTFS

Service Unique ID 137

Is Complete []

Comment Tr 8) T @

[E] New Attachment transaction X Delete (& Link g2 Unlink = Goto

AttachmentID T AttachmentReclD ¥ ConnectorTransld ¥ IsHEAT Rel¥. Created By ¥ Created On b 4

fbb9d2a4-0b6e-4beb-a527-081...  AOD5E59331494211ATB2F4ABS5. 18A2F0AA5F114EE8B4DIODFE true Admin 8/24/2016 1:20 PM

2¢680395-6330-47b0-9b82-765 02DFB18AE8604E9F89B5147D30... 18A2FO0AASF114EESBADIODFE... false Admin 8/24/2016 1:21 PM
Page Size 10 v Page 1 of 1 [

>

<

Fig.33
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e Login and Check in the TFS Connector Service
e The Attachment added in Ivanti Incident would be synced successfully and
displayed in the TFS Issue as shown in Fig.34

D Team Services /  MyFirstProject rekhaakshintala | @ & © @

HOME CODE WORK BUILD TEST RELEASE P~

Backlogs Queries
< ISSUE 139 10f 12 VB

~ New ) -
139 VTES issue creation

Assigned to me *

Y ) Save o
Followvedwonk s rekha.akshintala 73 Addtag S ® Follow O
Unsaved work items . - .
® Active ea MyFirstProject Updated by rekha.akshintala 2 minutes ago
4 Recent work items 1 . .
New lteration MyFirstProject Details O gm

Issue 139

4 My favorites Attachments
Drag queries hereto addthemtoy... | prag and drop attachments or click here to browse.

4 Team favorites

Name T Size Date Attached Comments
Drag shared queries here to add the...

ad warningjpg === 310K Monday, August 29, 2016 11:50:06... Spec for the work
» My Queries

» Shared Queries

] Recyclegin

Fig.34

4. Attachments Incoming

e Navigate to the TFS Issue

e Add an Attachment to that issue

e Now navigate back to the transaction record detail view
e Click the Action Menu at the top right

e Click Connector

e Scroll to the required connector service item

e Click TFS Sync Attachments Incoming as shown in Fig.35
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o - Ad trator Admi Confi Applicati
+ ® Home - Incident - Service Request - Problem - Change More... [ ] S et N Sounts Apolication o -
a & Administrator ® Help
Home  Incident Saved Search: All Active Incidents Incident: 11098 Connector Senice Transaction »# Watch List v
Show All v (record 1 of 24 search records) € > = Fiy
@) Redmine Create Issue
A List View [E New Connector Transaction 3 Save > Refresh V¥ Action menu v

@) Redmine Sync Attachments Incoming
Connector  »

& Edit Actions

Ticket Sharing and Synchronization R Rediiinid Sy AttaChiment= Qi uiG

@3] Redmine Sync Comments Incoming

ParentLink 2A253D8526F244C4A3653012E83DFCA4

2] Redmine Sync Comments Outgoing
TSSRecID  805D9D2A02D34CCC8B551E2969A5B960 "
2] Redmine Sync Issue
Service Name VSTFS
3] Salesforce Create Issue
Service Unique ID 139 g
3] Salesforce Sync Comments Incoming
Is Complete [] i 4
@) Salesforce Sync Comments Outgoing

3] Salesforce Sync Issue
@) TFS Create Issue

Comment T ions (3) T ions (1)

[E! New Attachment transaction X Delete (&' Link g2 Unlink - Goto

@3] TFS Sync Attachments Incoming

AttachmentiD ¥ AttachmentRecID ¥ ConnectorTransld T Is HEAT RelY. Created By
2] TFS Sync Attachments Outgoing
c5faf666-79d4-40da-b880-2c28...  78CO044FAEOF40E984CF15A55E... 09CF28A726514E5F925335B11...  true Admin . 3
2] TFS Sync Comments Incoming
@] TFS Sync Comments Outgoing
@] TFS Sync Issue Y
< >

Fig.35

e A new Attachment transaction record would be created and displayed in the
Attachment Transactions tab

e Check the incident record in Ivanti, a new attachment would be synced from TFS
and displayed successfully as shown in Fig.36

T " Administrator Admin Configure Application
+ ® Home - Incident - Service Request - Problem - Change More... [ ] ; BN Cono i o -
& Administrator ® Help
Home Incident Saved Search: All Active Incidents Incident: 11098 Connector Semvice Tran: » Watch List v
Show All Active Incidents v  (record 1 of 64 search records) € > Search for Incident Qi
A List View [E NewIncident v\ Apply Template v 2k Save & Refresh  Pinit @B Share % Assign Incident to Me Add New Task gClose Incident  d%3Add Problem  #89 Print Incident  »
[l Related items »
Summary Attachment Asset
VITFS issue creation Q (@ Aitach file [ Paste from clipboard & Link &2 Unlink VIFSiisslieicreation Q
Description Knowledge (13) .
Description for isssue creation in TFS zAbﬂ;ﬂ;:’:; ?;-‘;Cm How do | report an Issue using a Templ
[EEER| Admin 8/29/2016 5: Review the list of commonly reported
issues in the Report an issue using
template pane
warning jpg |
[T | Admin 8/29/2016 5:19PM How do | report a New Issue?
,  Review the list of commonly reported
% X T issues in the Report an issue using
Service Mobile Communication b — template pane
Category  International Dialing Failure v @ Create ¥ 22 Unlink How do | resolve my own issue?
Source’ [\Phona - While reporting a new Issue, you can
: resolve it immediately if a Knowledge
| Medi . Admin A New Attachemt Uploaded Successfully with 149C9FA article provides a resolution.
mpact; | Meduny 8/29/2016 524 PM  VSTFS
Urgen Medium - Add a User Account to BlackBerry Ent...
gency Add a User Account to BlackBerry
Priority 3 Admin VSTFS (139_3) Enterprise Server Software v5.0 and
Declare as Master Incident 8/29/2016 5:17 PM From VTFS to HEAT v Higher v

Fig.36
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Note: The maximum size of the attachment is as allowed by the Ivanti SM. Currently it is 5 MB.

5. Synclssue

e Navigate to the TFS Issue
e Update the status of the issue to Closed as shown in Fig.37

D Team Services /  MyFirstProject rekhaakshintala | @ & © ©

HOME CODE WORK  BUILD  TEST  RELEASE peoid

Backlogs Queries
B SsUE 133 10of 12 v 8
139 VTEFS issue creation

~ New a0

Assigned to me *

4 rekha.akshintala 4 Add tag Save B Follow (&)
Followed work items
Unsaved work items - <
® Closed Area MyfFirstProject Updated by rekha.akshintala just now
4 Recent work items ]
Issue Resolved teration MyFirstProject Details O (TNE)
Issue 139
~
4 My favorites Description 2w Planning ~ Development 58w
Drag queries here to add them to y... Stack Rank + Add link
4 Team favorites Description for isssue creation in TFS Development hasn't started on this item.
Drag shared queries here to add the...
2 B
iy Chueifas ) Related Work 05
» Shared Queries - + Add link v
There are no links in this group.
] Recycletin
v

Fig.37

e Now navigate back to the transaction record view in Ivanti SM
e Click the Action Menu at the top right

e Click Connector

e Scroll to the required connector service item

e Click TFS Sync Issue as shown in Fig.38
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. . Administrator Admi Configure Applicati
+ ® Home : Incident - Service Request - Problem - Change -  More... [ ] S et N Sounts Apolication o -
a & Administrator ® Help
Show All v (record 1 of 24 search records) € > = Fiy

@) Redmine Create Issue

A List View [E} New Connector Transaction 3, Save > Refresh V¥ Action menu v

@) Redmine Sync Attachments Incoming

Service Name | VSTFS @) Redmine Sync Attachments Outgoing Connector >
Service Unique ID 139 3] Redmine Sync Comments Incoming & Edit Actions
Is Complete [] 3] Redmine Sync Comments Outgoing
—————— @] Redmine Sync Issue
Comment Ti ions (7) Ti ions (3)

3] Salesforce Create Issue

[E! New Comment Transaction X Delete (&’ Link g2 Unlink - Goto @) Salesforce Sync Comments Incoming

Comment ID ¥ Connector Transaction ID ¥ Note ID ¥ Is HEAT Related ¥ Created By 7 @) Salesforce Sync Comments Outgoing
139_6 09CF28A726514E6F925335B1149. . 62B9BFBDICIAA3IDA .  false IntemalSeni 3] Salesforce Sync lssue A
10 09CF28AT26514E5F925335B1149. . CFA43I0AEAATIAL2376. .  true IntemalSeni .
@) TFS Create Issue
139.4 09CF28AT26514E5F925335B1149...  14EODAA50CE4D808...  false InternalSeni.. - )
10 09CF28AT26514E5F925335B 1149, 578259FESICBIAA93 ..  true Admin -l TES:Sypeittachments Incoming
139_3 09CF28AT26514E5F925335B1149...  IDTA2795TAF24TAEA . false Admin @) TFS Sync Attachments Outgoing
139_2 09CF28A726514E5F925335B1149 . 53C5A45388C04BBDY. . true Admin &) TFS Sync Comments Incoming N
Page Size 10 v @] TFS Sync Comments Outgoing a
3] TFS Sync Issue A
< - >
Fig.38
e Navigate to the Incident record
e Check the status
e |t would be Closed as shown in Fig.39
: ) Administrator Admi Configure Applicati
+ ® Home : Incident - Service Request - Problem - Change -  More... S enait \ Sounuts Application o -
aln & Administrator ® Help

t Sharing and Synchronization Change Connector Se Transaction Incident: 11098 # Watch List v

Show All v (record 1 of 562 search records) € = Search for Incident Qle

A List View [E NewIncident v v Apply Template v 2 Save ¢ Refresh »* Pinlt @ Share <% Assign Incident to Me Add New Task g Close Incident L“Add Problem 9 Print Incident  »

~

* Incident: 11098 (Closed)

Customer & Owner

Customer  Administrator Admin Status~ Closed Response Target:  8/31/2016 5:30 AM
I Breached 8/31/2016 5:30 AM
Resolution Target: 9/3/2016 5:30 AM
Owner  Administrator Admin . 7 hours 16 minutes left For 3rd escalation 4

admin@saasitdemo.com Team  Service Desk
7195551254

Details  Task (0) Master Incident

Summary Attachment Asset Audit Info
VTFS issue creation Attach file [ Paste from clipboard Link R Unlink CIRAISA Ty Nemidy A2BI2016 S0SPM
Modified By Admin, 9/212016 2:35 PM
Description ;i
r gy . — Closed By Admin, 9/2/2016 2:35 PM
| Description for isssue creation in TFS Obsenvations Defec
I3 Admin 8/29/2016 5:24PM
v
< >

Fig.39

e Inthe transaction record, check the Is Complete option
e |t would be checked indicating that the incident has been closed as show in
Fig.40
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F’ + ® Home : Incident - Service Request - Problem - Change -  More... @ | sdpiniststo i N Sounts Apolication O -
aln & Administrator ® Help
Show All v (record 9 of 22 search records) € > Fiy
A List View [E New Connector Transaction 3, Save > Refresh V¥ Action menu v

~

Ticket Sharing and Synchronization
ParentLink 4CDA179A27B34F299F58E2256555290D
TSSReclD  805D9D2A02D34CCC8B551E2969A5B960
Service Name VSTFS
Service Unique ID 137
Is Complete

Comment Ti (8) Ti ions (2)

[E! New Attachment transaction X Delete (&' Link g2 Unlink - Goto

AttachmentiD ¥ AttachmentRecID " ConnectorTransld T IsHEAT Rel¥. Created By v Created On
fbb9d2a4-0b6e-4beb-a527-f081...  AOD5E59331494211A7B2F4AB85... 18A2F0AASF114EESBADIODFE... true Admin 8/24/2016 1:20 PM
2e680395-6330-47b0-9b82-765. 02DFB18AEB604E9F89B5147D30...  18A2F0AASF114EESB4DIODFE... false Admin 8/24/2016 1:21 PM
v
< >

Fig.40

Note:

1. Not all the Connector Services have all the Action items. Please refer the table in
Section 2.
2. Repeat the above steps 1 to 6 as applicable for each of the connector service

6 Logging

The Administrator can refer the log file or Logs workspace for any troubleshooting or Analysis.

The error / activity information is logged into a log file AppServer which is located in the path C:\
Logs\ on the server the application is hosted. This is then automatically uploaded into the Logs
workspace.

The Administrator should ensure that the configuration of the log is properly updated.

Navigate to the workspace Logging Configuration
Double click the SCRIPT Service Name

Set the Log Level to ALL as shown in Fig.41

Click Save

i s
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) ) Administrator Admi Configure Applicati
W + ® Home - Incident - Service Request - Problem - Change -  More... [ ] el A Contiads Application o -

a & Administrator ® Help
Home Incident Saved Search: All Active Incidents Incident: 11098 nice Transa
Show All v (record 4 of 15 search records) € > xa
A List View [E NewRecord o Save ' Refresh V¥ Action Menu v
Logging Configuration 5
Service Name Séript v
Log Level ALL v

Audit History (1)

Date ¥ User Y EventType ¥ Description Y 1
8/23/2016 4...  Admin Update [Log Level] changed from [ERROR] to [ALL]

Fig.41
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Following is the sequence of steps to check the logs.

1. If using the Log files:
a. Inthe Application Server, navigate to the folder C:\Logs or the Logs workspace
b. Check for the file AppServer of type FRSLOG
c. Open thefile
d. The file displays any errors or activity logged as shown in Fig.42, Fig 43
2. If using the Logs workspace.
a. Open the workspace
b. Filter for appropriate logs
c. The records display any errors or activity logged. This will be similar to what is
shown in Fig.42, Fig 43 but will be in log workspace format

:\Logs'AppServer.frslog - Notepad-++ [Administrator]

File Edit Search View Encoding Language Settings Macro Run Plugins Window ? X
cHEHB B Mk|De |(mk|t s BE (%1 IEOD e | ED B

[= AppServer.frslog 3 l

1 =

Ticket Sharing and Syncronization Started - Issue Create.

Identified Business object as Incident#

Identified Service as VSTFS

Fetching BO Details from Incident#

Successfully Fetched BO Details from Incident#

Creating Json For Post Data

Getting Required Field value for System.Title

successfully sending BO Field value for System.Title
Getting Required Field value for System.Description
successfully sending BO Field value for System.Description
Completed Creating JSON Post Data

Post Data for service request Created Successfully:
[{"path" : "/fields/System.Title”, "op” : "add"”, "value” : "test"},{"path” : "/fields/System.Description”, "op" : "add", "value" : "test"}]

Getting Required Field value for project
successfully sending Default Field value for project
Request URL:https://heatconnector.visualstudio.com/DefaultCollection/MyFirstProiect/ apis/wit/workitems/$Issue?api-version=1.0

Before Sending Request to Service -VSTFS

1 Response Successfully from the Service -VSTFS

21
2133 Validated response Successfully from the Service responsed :200
IR >

Normal text file length : 10147398 lines : 12187 Ln:12168 Col:1 Sel:0]0 JUnIX JutF-8 ins

Fig.42
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M *C:\Logs'\AppServer.frslog - Notepad ++ [Administrator]

File Edit Search View Encoding Language Settings Macro Run Plugins ‘Window 7 X
cHEHE B s+Mk|oe |kt EE(S1[FIEND |6 =D BB
= AppServerisiog 3 |

S1  Ticket Sharing and Syncronization Started | A

Identified Business chject as Incident#

Identified Service as VSTFS

Fetching BO Details from Incident#

Successfully Fetched BO Details from Incident#

Start of Getting All Constants

Getting All Constants completed successfully

Before creating service request Object to :http://192.168.124.251/HEAT/ServicedPI/FRSHEATIntegqration. asmx
Service Request Object created successfully

Before invoking calling service reguest
FRSHEATIntegration. AuthenticateUser(...)

Service respond Successfully

validated Service respond authentication is :Success
FRSHEATIntegration.SetRoleForUserSession(...)

Fetching Attachment Details for current Incident
Conpleted Fetching Attachment Details for current Incident :AF61307B046748FDBDF7SE0067166C31

Completed Fetching Attachment Transaction Details for All Attachment
</ log4net :message><logdnet :properties><log4net :data name="ServerRoot” value="C:\Program Files\HEAT Softvare\HEAT\AppServer\"” /><log4net:data name="ErrorCode” v
<log4net:event loggyer="FrontRangeSaaS" timestamp="2016-09-02T15:35:01.6094+05:30" level="INFO" thread="72" domain="/LM/U3SVC/1/ROOT/HEAT-1-131172269757944000"
<log4net:event logger="FrontRangeSaaS” timestamp="2016-09-02T15:35:03.1174+05:30" level="INFO" thread="53" domain="/LM/W3SVC/1/ROOT/HEAT-1-131172269757944000"
<log4net:event logger="FrontRangeSaaS" timestamp="2016-09-02T15:35:04.6234+05:30" level="ERROR" thread="74" domain="/LM/W3SVC/1/ROOT/HEAT-1-131172269757944000"

. POST:http://savitrsp/HEAT/ServiceAPI/EventSubscription/E iptionService.asmx</logdnet: logé4net:properties><logdnet:data name="Servex:Roor.":lj

-
»

Normal text file length : 10147398 lines : 12187 [ln:12151 Col:44 sel:0|0 UNIX UTF-8 s

Fig.43

7 IMPORTANT

Please note the following important aspects in the Ticket Synchronization Framework.

1. Once the package is imported and Ticket Synchronization Framework is installed, the
configuration values for the connectors display some pre-configured sample data. The User
MUST update / change the sample data and add / remove the fields as need for his current
Ticket Synchronization Framework instance.

2. For the Ticket Synchronization Framework Bugzilla, during configuration ensure that the
Description field the option “Poll this field for any changes” should be unchecked always

3. The comments in Salesforce should be added in Case Comment section

4. This User Manual only illustrates the configuration for the Incident Business Object; if the Ivanti
SM instance has a different business object to be mapped, then the Administrator has to create
the new business object and configure. Please contact your System Administrator for advance
configuration.
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8 AppendixI - Other Details

These details cover settings that are normally not required to be adjusted, but are included here in case
new integrations are being designed.

8.1 Scheduled Job

After the package(s) have been imported successfully, a pre-configured scheduled
job would be created. This scheduled job executes every 1 hour and runs the
different active quick actions.

1. Navigate to Settings -> Monitor ->Scheduled Jobs
2. Search for the job “Hourly Schedule” of Type “Hourly Schedule”
3. The Schedule Job is displayed in the list as shown in Fig.44

' Administrator Admin Project: @ Help @
aln & Administrator Default
Settings EQ K Monitor » Scheduled Jobs
Page Layouts ~
; 9 z Y Show All v (35 search records) Schedule Entry v Search for Schedule Er Q%2
Pick Lists
Reports B New v X Delete & Refresh E%View Workflow W Action Menu v
» Search Tools
» User Interface Styles Type ¥ Name ¥ StatTime ¥ EndTime ¥
ot WUy SLnIEAUIE Ui Lust sevice v oUW =
N H;ATEMCE] o MonthlySchedule Monthly Interval 245 PM 3:00 PM
S Devel"pme"t P"”zc HourlySchedul HourlySchedul 1200AM  1159AM
i UG DailySchedule Senice Allocation Calculation Daily Sc... 1:00 PM 5:30 PM
# Extend DailySchedule CMDB Import 4:30 PM 7:30 PM
¥ Integration Tools DailySchedule Purge Message Queue Journal 6:30 AM 7:30 AM
¥ Voice Integration DailySchedule Daily Subscription Scan for Transaction ~ 6:30 PM 7:30 PM
HEAT DSM Integration DailySchedule Non-Production Change Window 6:30 PM 6:29 PM v
SAP Integration Page Size 100 v A Page 1 of 1 =
HEAT Discovery
~
HEAT API Hourly Recurring Schedule
EMonitol
» Name: HourlySchedule
¥ Application Logs
System Audit History Start Time: 12:00 Al Your local time
Patch Logs Your local time: 12:00 AM
Scheduled Jobs . 11:59 Ar Your local time
— End Time:
Security History v Your Incal time- 1159 AM ¥

Fig.44

4. Click the record to view the details
5. The details are displayed as shown in Fig.45
6. The administrator can update the settings as required
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V

Settings

Page Layouts

Pick Lists

Reports
¥ Search Tools
¥ User Interface Styles
P Self Senice
» HEAT Development Project
» HEAT Development Package

% Extend
¥ Integration Tools
» Voice Integration
HEAT DSM Integration
SAP Integration
HEAT Discovery
HEAT API

I Monitor
¥ Application Logs
System Audit History
Patch Logs

Scheduled Jobs

Security History

A

v

Show All v (record 25 of 35 search records) €

EQ K Monitor » Scheduled Jobs » Scheduled Jobs: Hourly Schedule

A List View [El New o Save & Refresh v Action Menu +
~
Hourly Recurring Schedule
Name Fouﬂyg:h:dule ]
. 12:00 Al ¥  Your local time
Start Time
Your local time: 12:00 AM
11: P Your local ti
End Time 59 AN ¥ Your local time
Your local time: 11:59 AM
Recur Every 4 Hours
Start Date  7/29/2016
End Date No End Date ]
Workflow Instance (82)  Activity History (0) Integration (0)  Audit_History (0)
‘pAbort €Pause TPResume & Re-un 5

Administrator Admin
& @& Administrator

Project:
Default

@ Help @

Schedule Entry v Search for Schedule Er Q2

Fig.45



